
Software User Guide

For the safe use of your camera, be sure to read the Safety Precautions thoroughly before use.
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Using These Manuals

The two manuals included are for your Camera. 

1. Getting to know the usage of the 
camera

Camera User Guide (Printed manual)
This guide explains the usage and functions 
of the camera.You will also see how to install 
the provided software on your computer.

2. Getting to enjoy images on your
computer

Software User Guide (This booklet)
This guide explains how to download images 
from the camera to your computer, and how 
to display and edit them on your computer.

How to Use the 
Software User Guide

Display examples:
The LCD Monitor Display examples may be 
different from actual display screens.

Terms:
In this guide, still images, movies, and 
sounds are all referred to as "images" or 
"files."

Symbols:
This guide uses the following symbols and 
conventions:

Important
This indicates important notices and restrictions for 
using this camera.

Note
This indicates supplementary explanations and useful 
tips about camera operations.

Refer to
This indicates page(s) relevant to a particular function. 
"p.xx" is used to refer you to pages in this manual.

Term
This indicates terms that are useful for understanding 
the explanations.
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Chapter 1
Getting to Enjoy 
Images on Your 
Computer
(For Windows)

Section 1
Downloading Images to 
Your Computer
This section explains how to display still images and 
movies you have downloaded to your computer.
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Connecting the Camera 
to a Computer

After installing the software on your 
computer, connect your camera to it.

1. Make sure the camera power is
off.

2. Connect the USB cable to the 
USB port of your computer.

3. Connect the USB cable to the 
USB terminal of your camera.

Your camera turns on.

For Windows XP
The first time you connect your camera to the 
computer using a USB cable, the [Found 
New Hardware Wizard] screen will appear.

1. Select [Install from a list or
specific location (Advanced)].

2. Select [Next].

3. Select [Search for the best 
driver in these locations.] -
[Include this location in the 
search] and then press the 
[Browse] button.

4. Browse to the folder where the 
WIA driver was installed (by 
default this should be 
C:\Program Files\DSC 
Software\WIA driver) and then 
select [Next].
The WIA Driver is installed.
The [DSC 724] screen is displayed.
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5. Select [DL-10], check [Always 
use this program for this action] 
check box, and then click [OK].
• To load images from the camera with 

assistance from the Windows XP 
Scanner and Camera Wizard, select 
[Scanner and Camera Wizard].

• Leaving the [Always use this program 
for this action] check box unchecked 
will cause the [DSC 724] screen to be 
displayed each time you transfer 
images from the camera, thereby 
allowing you to choose whether to use 
DL-10 or the Scanner and Camera 
Wizard for image transfers.

• To disconnect the camera from your computer:

• It is recommended that you use the AC Adapter 
(sold separately) when you are downloading images 
from your camera.

1. Turn your camera off.
2. Unplug the USB cable.



7

Downloading Images to 
Your Computer

When you connect the camera to your 
computer, the images from the camera are 
automatically downloaded to the computer.
DL-10 is provided for downloading images.

When no SD memory card is inserted, the camera 
loads from the internal memory; when an SD memory 
card is inserted, it loads from the SD memory card. 

For Windows 98/98SE/Me/2000/XP
DL-10 automatically creates a folder called 
[Digital Camera] inside your [My Documents] 
folder. Downloaded images are saved in 
folders with the date of each shot, inside the 
[Digital Camera] folder.

1. Connect the USB cable to the
USB port of your computer.

2. Connect the USB cable to the 
USB terminal of your camera.

The camera turns on, DL-10 starts, and 
the DL-10 window appears.

Image transfer begins automatically.

• Images are stored with sequential numbers so that 
they have unique file names.

• File names given by the camera are not used. 
• Even when the storage folder is changed, the file 

number will be continuous. The number cannot be 
initialized. 

• When transferring images to a computer, if a file 
already exists with the same name in the destination 
folder, your image is renamed before saving to avoid 
overwrite problem.

• When transferring images to a computer via DL-10, 
the files are assigned names like IMAG****.jpg (**** 
indicates the number of the image), even if 
SEQUENTIAL NO." is set to ON.

Once download finishes, DU-10 
launches, and you can view the images.

When no memory card is 
loaded

When an SD Memory 
Card is loaded

Loads from internal 
memory

Loads from the SD 
Memory Card
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If the screen below appears, select "DL-
10", check the box next to "Always use 
this program for this action" and then 
press [OK].

• Before closing DL-10, if you turn the camera power 
off, or unplug the USB cable, the DL-10 window is 
minimized and displayed as an icon on the Windows 
task bar.  If you click the icon, the window will be 
displayed again.

• After exiting DL-10 by pressing the [MENU] button 
and selecting [Close], if you want to restart DL-10, 
select [Programs] from the [Start] menu then select 
DSC Software then DL-10.

• You can change the folder for downloading your 
images (Save Destination).

• For how to change the Save Destination Folder, see 
P.11.

• For how to start DL-10, see P.9
• For DL-10 screen, see P.9
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How to Use DL-10

DL-10 is a software program to import 
images from the camera to a computer.
By simply connecting the camera to your 
computer via a USB cable, images are 
automatically imported to the computer.
On the DL-10 window, you can make various 
settings including auto-saving upon 
connection and the destination folder (where 
images will be saved).

Starting
DL-10 is already installed with DSC 
Software.
Connecting the camera to your computer 
automatically starts the software and begins 
downloading of images from the camera.

Quitting
To quit DL-10, follow either of the steps 
below.
• Click the [MENU] button on the DL-10 

window and select [Quit] from the 
displayed menu (see "DL-10 Window").

• Right-click the DL-10 icon on the task bar 
and select [Quit] from the displayed menu.

Restarting
To restart DL-10 after quitting, follow the 
steps below.
• From the [Start] menu, select [All 

programs] (or [Programs]) → [DSC 
Software] → [DL-10].

The DL-10 Window
Once DL-10 starts up, the following DL-10 
window appears on your computer screen.

1. [MENU Button]

Click this and the following menu appears.

2. [Save Button]

Click this and the images are downloaded 
from your camera.

If the message indicating that "The camera is waiting 
to be connected... , Press the ADJ. button to initiate 
direct printing" appears on the camera LCD monitor, 
do not press the Save button.

3. [Application Button]

The application registered in Optional 
Settings is launched. DU-10 is specified 
initially.

[Option settings] Specifies where to save 
images, or which application to 
launch when you press the 
Application button and after 
saving. (P.11)

[Background 
illustration settings]

Changes the background 
design in the DL-10 window. 
(P.12)

[About] Displays the version of DL-10.
[Quit] Closes DL-10.
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4. [Minimize Button]

Minimizes the window and displays its icon 
on the Windows task bar. If you click on the 
icon, the window will be displayed again.

5. [Indicator]

The [indicator] lights if the camera is 
connected via USB cable. When lit, if you 
put the mouse pointer on the [Indicator], it 
displays "Camera Connected." When your 
camera is not connected, the [Indicator] is 
grayed out, and if you put the mouse 
pointer on it, "Camera Connected" does 
not appear.
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How to Use the Optional Settings
If you select [Option settings] from the menu 
displayed on a button in the DL-10 window, the 
[Option settings] dialog box appears.

Item Description Initial Setting

1. [Automatically save 
on connection]

If you check this box, once your camera is connected to the computer, 
images are automatically downloaded and saved. If you uncheck the box, 
your images will not be download automatically when you connect your 
camera to the computer. Click the [Save] button when you want to 
download.

Execute auto save

2. [Destination folder] Specifies which folder to save your images in. The [Digital Camera] folder 
inside [My Documents] is specified initially; if you want to change this, click 
the [Browse] button to display the dialog box and then specify the folder.

3. [Create folder] Specifies how to create a folder.
[Do not Create]
Your downloaded images will all be saved in the folder specified in item 2.
[For each date photographed]
Creates a new folder assigning the date the images were shot as the folder 
name, and saves images shot on the same day in the same folder.
For example, if shot on May 1, 2004: [20040501] folder
[For each time saved]
Creates a new folder for each time images are saved and saves the images 
shot at the same time in the same folder. If you save several times in one 
day, they are saved in separate folders each time.
The name of the folder created is "Date, Underscore, and 3 digits sequence 
number".
For example, if you saved twice on May 1, 2004: [20040501_001] folder, 
[20040501_002] folder

Each day shot.

4. [The same image will 
not be saved.]

You can specify this only when you have selected either [Do not Create] or 
[Each Day Shot] in [Create a Folder] or if in [Create a Folder] you did not 
check [Do not save same image when saving].
Images imported once are not imported anymore.To allow the function to 
work properly, the camera's clock information must be set properly.

Do not save same 
image.

5. [Application software 
settings]

Specify the name of the application you want to launch after you save.The 
DU-10.exe (the file name of DU-10) is specified initially; if you want to 
change this, click the [Browse] button to display the dialog box and then 
specify which application to use.

6. [Save and start 
application software]

If this is checked, an application will be launched after saving.
If this is unchecked, no application will be launched.

After saving. 
Launch 
application.

7. [Camera IP Address] Not used by this model but used by other models of camera. For details, 
see the documentation that came with the camera.

0.0.0.0
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How to Use the Background 
Illustration Settings
You can select a background for the DL-10 
window from three types of patterns.
If you select [Background illustration setting] 
from the menu displayed by the [MENU] 
button in the DL-10 window, the [Background 
illustration settings] dialog box appears.

1. [Background illustration pattern]
Select the pattern you wish to use from 
the three available.

2. [Preview]
The pattern selected in [Background 
illustration pattern] appears, and you can 
configure it.

Downloading Images 
from an SD Memory 
Card

It is possible to download images from a 
memory card to computer via a PC Card Slot 
or Card Reader.
To load an SD Memory Card into a PC Card 
Slot or Card Reader, use the PC Card 
Adapter (sold separately).

Images in an SD Memory Card
Images are stored on an SD Memory Card in 
a hierarchy, as shown here.

If the card reader is SD Memory Card compatible 
(directly loadable), no PC Card Adapter is required.

Card Reader
This is a device that connects to a computer and can 
read the contents of cards. In addition to the PC Card 
type, there are Card Readers compatible with various 
types of cards, into which you can directly load a 
memory card.

Image files



Section 2
Displaying Thumbnail 
Images (How to Use DU-
10)
DU-10 allows the following edits and corrections on 
images downloaded to your computer:

• Listing
• Resizing
• Cropping
• Rotation
• Auto/manual correction
• Renaming a file
• Copying/Reduced copying
• Deleting
• Viewing image information
• Printing

This section explains how to use DU-10.

DU-10 runs in a Windows environment.
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Starting and Quitting DU-
10

There are two methods for starting DU-10:
• Auto Start from DL-10In the DL-10option 

settings, if the Application Software is set 
to DU-10, and if [After saving, launch 
Application software] is checked, DU-10 
will start automatically after image files 
have downloaded from your camera with 
DL-10.

• Start from Windows [Start] menu
Select [Program] then [DSC Software] then 
[DU-10] from the [Start] menu to start the 
software.

The DU-10 Window
Once you start DU-10, a window like the one 
below appears.

The images you saved are displayed all in 
one window. This method of displaying 
reduced size images is called thumbnail 
display.

Quitting DU-10
To quit DU-10 and close its window, select 
[File] from the menu bar, then select [Exit] 
from the menu displayed, or click the [X] 
(Close) button in the upper right corner of the 
screen.

For how to set DU-10 so that it does not launch 
automatically, see P.9.
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Thumbnail Display 
Description

Once you start DU-10, images appear as 
thumbnails.

1. Menu Bar
You can change the display size and 
ordering of images.

2. Tool Bar
Of the functions available in the menu, the 
icons of those most frequently used are 
displayed, so you can use those functions 
with just one simple click.

Properties (see P.24)
Displays image information.

Open (see P.25)
The Viewer screen opens to 
display selected images.

Arrange (see P.16)
Images are rearranged 
according to the option selected 
from the menu.

Display size (see P.17)
Thumbnails are displayed in a 
size selected from the menu.

Display all files below folder 
Selecting this option displays the 
images in all subfolders as 
thumbnails.

Auto Slide Show (see P.19)
In Auto slide show, all the images 
displayed as thumbnails appear in 
order.

3. Thumbnail Display Area
The reduced images are displayed at one 
glance.

4. Folder Display Area
The folders inside [My Computer] are 
displayed in a hierarchy. The images 
inside folders selected here appear in the 
Thumbnail Display Area.

5. Thumbnail Image

6. File Name

7. Sound Setting Y/N Display
A yellow speaker icon is displayed for an 
image with sound.
Double-clicking the speaker icon allows 
you to play back the sound.

8. Memo Setting Y/N Display
A red pencil icon is displayed for an image 
with camera memo.
Double-click the pencil icon to display the 
[Edit Memo] dialog box, where you can 
edit the camera memo.
Note This Camera does not allow camera 
memos to be attached to images.

9. Search Bar Area
By specifying a keyword, you can search 
images with corresponding camera 
memos and display them as thumbnails.
This option is displayed only when the 
[Enable Camera Memo Function] check 
box is selected.
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Switching the Ordering 
of Images

Displayed thumbnail images are ordered 
according to date (descending order).
You can change the ordering method to by 
file type or by name.
You can also choose whether each of the 
above is ordered according to ascending or 
descending order.
To rearrange images, select [Arrange] from 

the View menu or click the [Arrange] 
icon on the toolbar.

1. Name order
Switches to By File Name.

2. Type order
Switches to By File Type (in alphabetical 
order of the extension).

3. Date order
Switches to By Date Shot (or By Date 
Updated if edited).

4. Ascending/ 5.Descending
Ascending order is going from small to 
large, the opposite is descending order. 
For the alphabet, ABC is ascending order, 
and ZYX is descending.
Select which order to use, 1, 2 or 3 and 
choose either ascending or descending 
order.

If you order by file type, the files are ordered 
alphabetically according to the file extension.
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Changing the Display Size

To change the display size, select [Display 
size] from the View menu or click the 

[Display size] icon on the toolbar.

Menu

Tool Bar

You can change the display size to one of six 
sizes available.
1. Extra-

large

2. Large

3. Medium

4. Medium
+
memo

5. Medium
+
GPS

6.Small

Since this camera does not support the camera memo/
GPS functions, the display sizes [Medium + Memo] 
and [Medium + GPS] are not available (disabled).
[Medium + Memo] and [Medium + GPS] can be 
selected when you are using another camera.
Note that [Medium + Memo] and [Medium + GPS] can 
also be enabled.
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Viewing Images in a 
Slide Show

You can view images sequentially and 
automatically in either a slide show (selected 
images only) or auto slide show (all images). 

To View a Slide Show
You can select one or more images and 
display them as a slide show.
To start slide show, follow the steps below.

1. Select the images you wish to 
see in slide show.
If you want to select multiple consecutive 
images, after clicking the first image, 
press and hold the [Shift] key and click 
the last image.
To select multiple images that are not 
consecutive, press and hold the [Ctrl] 
while clicking each.

2. Using one of the steps below, 
select [Slideshow].
• Select [View] then [Slideshow] from 

the menu bar.
• Place the pointer of the mouse on one 

of the images you selected, right click 
and choose [Slideshow] from the 
menu.

Menu

Shortcut menu displayed with right click

3. The [Slideshow] dialog box is 
displayed, so make the 
necessary settings.

4. Click the [Run] button.
The slide show begins.

Running a slide show

Type of slide 
show Key Function

[AUTO] is 
selected in step 
3.

[ESC] Key Stops the slide 
show.

[MANUAL] is 
selected in step 
3.

[ESC] Key Stops the slide 
show.

Left-click 
Mouse
[Space] Key
[Enter] Key
[→] Key

The next image is 
displayed.

[Backspace] 
Key
[←] Key

The previous 
image is 
displayed.
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Using Auto Slide Show
In Auto slide show, all the images displayed 
as thumbnails appear in order.
To start Auto slide show, follow the steps 
below.

1. Using one of the steps below, 
select [Auto slideshow].
• Select [View] then [Auto slideshow] 

from the menu bar.
• Place the pointer of the mouse on one 

of the images you selected, right click 
and choose [Auto slideshow] from the 
menu.

The slide show begins.
The images advance automatically 
according to the display interval (number 
of seconds) you specified in the 
[Slideshow] dialog box.
Stop the slide show with the [Esc] Key.

• To automatically switch between images while 
viewing an auto slide show, select [Auto] in 
[Operating method] in the [Slideshow] dialog box.

• When [Manual] is selected in [Operating method], 
switch between images by pressing the [Enter] key 
or clicking on images in auto slide show.

How to Use the Slide Show Dialog 
Box
You can make slide show display settings in 
the [Slideshow] dialog box.

1. [Operating method]
Select either Auto slide show (the slides 
are played automatically, in order) or 
Manual (switch frames by clicking the 
mouse button or pressing the [Enter] key).

2. [Display interval]
Specify how long in seconds to display 
each image, when using Auto slide show.

3. [Background color]
Choose a background color for your 
images.  Click the [Choose Color] button 
and choose a color from the dialog box 
that appears.

4. [Display file name]
If you check this box, the file name will 
appear in the bottom of the image.

5. [Maximum display]
If you check this box, your images will be 
displayed at full-screen size.

6. [Playback sound]
If you check this box, and the images 
have associated sounds, the sounds will 
also be played back.

7. [Repeat]
If you check this box, the sets of images 
will be shown repeatedly, until you press 
the [Esc] key to stop. If you uncheck this 
box, the images in the folder will be 
displayed through the cycle once, then 
the slide show will finish.
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Playing Back the Sound 
Recorded with an Image

You can play the sound associated with an 
image that was shot with a camera function 
such as [Image With Sound].

To Play Back the Sound Recorded 
with an Image
1. Select the image with which the 

sound is associated.

2. Using one of the steps below, 
select [Play Associated Sound 
File].
• Select [View] then [Play Associated 

Sound File] from the menu bar.

• On the image you selected, right click 
and choose [Play Associated Sound 
File] from the menu.

Refreshing the View

If the current screen is not up-to-date after 
the folder contents are modified, follow the 
procedure below to refresh the screen.

1. Select [View] then [Display latest 
information] from the menu bar.
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Renaming an Image

You can rename an image shown on the 
Thumbnail Display screen.

How to Rename an Image
To rename an image shown on the 
Thumbnail Display screen, follow the steps 
below.

1. Select an image you want to 
rename.

2. Using one of the steps below, 
select [Rename].
• Select [File] then [Rename] from the 

menu bar.

• On the image you selected, right click 
and choose [Rename] from the menu.

3. When the [Rename] dialog box 
appears, enter the new name for 
the image.

4. Click the [OK] button.

Renaming Image Files 
in Batch (Sequential 
Rename)

Several image files can be renamed together.
You can give file names of the following 
format:

To rename image files in batch, follow the 
steps below.

1. Select an image you want to 
rename.
If you want to select multiple consecutive 
images, after clicking the first image, 
press and hold the [Shift] key and click 
the last image.
To select multiple images that are not 
consecutive, press and hold the [Ctrl] 
while clicking each.

2. Select [Tools] then [Continuous 
Rename] from the menu bar.

Spring_0001.JPG
Prefix 
characters

Underscore Sequence number 
with the specified 
digits
The start number
can be specified.
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3. When the [Continuous Rename] 
dialog box appears, specify the 
prefix characters, underscore 
(with or without ), start number, 
and digits.

4. Click the [OK] button.

Copying a Reduced 
Image File

You can reduce an image shown on the 
Thumbnail Display screen and copy it onto 
the clipboard.
Available scale options are 100%, 1/2, 1/3, 1/ 
4, 1/8 and 1/16.
For example, when you paste a shot image 
onto a Windows application document and 
find the image too large for your document 
size, you can reduce the image using this 
function in advance and paste it into the 
document via clipboard.

How to Copy an Reduced Image 
File
To reduce an image file size and copy it onto 
the clipboard, follow the steps below.

1. Select an image you want to 
reduce.

2. Using one of the steps below, 
select [Copy Image].
• Select [Edit] then [Copy Image] from 

the menu bar.
• On the image you selected, right click 

and choose [Copy Image] from the 
menu.

3. When the scale options appear, 
select a scale from the menu.

4. Paste the image from the 
clipboard to another Windows 
application.
For example, when using Paint from 
Windows Accessories, start Paint, and 
then select Paste from the Edit menu.
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Deleting Images

You can delete images.
There are three methods for deleting images.

Using the File Menu
1. Click an image you want to 

delete in the Thumbnail Display 
Area.

2. Select [Delete] from the [File] 
menu.

Using the Shortcut Menu
1. Right-click on the image you 

want to delete in the Thumbnail 
Display Area.
The shortcut menu appears.

2. Select [Delete] from the menu.

Using the Keyboard
1. Click an image you want to 

delete in the Thumbnail Display 
Area.

2. Press the [DELETE] key on your 
keyboard.
A message appears to confirm the 
deletion.

3. Click the [OK] button.
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Viewing Image 
Information

You can display image information, such as 
the date and time a photo was shot, the size 
of the image, and so on.
To display image information, follow the steps 
below.

1. Select the image you want to 
display its information.

2. Using one of the steps below, 
select [Properties].
• Select [File] then [Properties] from the 

menu bar.

• On the image you selected, right click 
and choose [Properties] from the 
menu.

• Click the  [Properties] icon on the 
tool bar.

The [Properties] screen like the one below 
appears.
The [Properties] window has the [General] 
tab displaying the shooting date and time and 
other information and the [Details] tab 
displaying the camera settings at shooting.

[General] tab on the [Properties] screen

[Details] tab on the [Properties] screen

The [Details] tab above displays information that 
applies to this camera. The contents displayed on the 
[Details] tab may differ depending on the camera.
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Displaying the Viewer 
Screen

If you use the Viewer screen, images are 
displayed at full size, not as thumbnails.
To open the Viewer screen, follow one of the 
steps below.
• Double click the image you want to display 

from the thumbnail selection.

• Click the image you want to display from 
the thumbnail display area, then select 
[Open] from the [File] menu.

Using the Viewer Screen

Viewer Screen

1. Menu Bar (see P.29)

2. Tool Bar

[Save As] (see P.26)

[Return to Original] (see P.26)

[Select Range] (see P.26)

[Copy] (see P.26)

[Rotate 90C× counter-clockwise] (see P.26)

[Rotate 90C× clockwise] (see P.26)

[Resize] (see P.26)

Cropping (see P.26)

[Auto Image Correction] (see P.27)

[Manual Image Correction] (see P.27)

[Actual size view] (see P.28)

[Overall view] (see P.28)

[Enlarged Display] (see P.28)

[Reduced Display] (see P.28)
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What You Can Do with the Toolbar
By using the icons on the toolbar, you can do 
the following:

[Save As]

The [Save As] dialog box appears where you 
can save the image file. Modifyint the file 
name allows you to save the image as a new 
one. You can also change the file type or 
compression ratio as required.

[Save As] dialog box

To save under a new file name, follow the 
steps below.

1. Select [Save as...] from the [File] 
menu.
The [Save As] dialog box appears.

2. Specify where to save the new 
file in [Save in].

3. Enter the name of the new file in 
[File Name].

4. Change the file type or 
compression ratio as required.

5. Click [Save].

[Return to Original]

Cancel changes made on the Viewer screen 
and restore the original.

[Select Range]

You can select a range by clicking and 
dragging.This is used to copy the selected 
range in an image.

[Copy]

An image can be saved to clipboard and then 
pasted into another application. If a range is 
selected with [Select Range], only the 
selected range is copied. Otherwise, the 
entire image is copied.

[Rotate 90C× clockwise]

[Rotate 90C× counter-clockwise]

You can rotate your images 90 degrees to the 
left or right. You can correct images to their 
proper vertical/horizontal orientation.

[Resize]

The [Resize] dialog box appears where you 
can resize the image to 1/2, 1/3, 1/4, 1/8, or 
1/16.

[Resize] dialog box

[Cropping]

You can crop a part of the image.When you 
click and drag to select a range, a message 
appears to confirm cropping. Click the [OK] 
button to crop the image.
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[Auto Image Correction]

The brightness, contrast, sharpness, and hue 
are automatically adjusted to enhance 
images.The [Auto Image Correction] dialog 
box appears where you can preview the 
enhancement.

[Auto Image Correction] dialog box

[Manual Image Correction]

The [Manual Image Correction] dialog box 
appears where you can adjust the 
brightness, contrast, sharpness, and hue by 
dragging the slider sideways.

[Manual Image Correction] dialog box

The arrow keys are very useful for fine tuning 
the slider position.
Dragging each slider produces the following 
effects:
Original image

Brightness
Select the brightness level for an entire 
image. 

Contrast
Adjust the contrast level. You can increase or 
decrease the contrast of an image to make it 
sharp, or dull and flatter.

Sharpness
An image can be made obscure or crisp.

Slider

- +

- +

- +
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Gamma
The brightness of intermediate area can be 
adjusted without affecting the darkest and 
brightest areas. This is useful for applying 
corrections on dark pictures.

Hue
The hue of an image can be adjusted toward 
blue (+) or red (-). 

Chroma
The color vividness can be adjusted.

If using the [Brightness] slider makes an entire image 
whitish or blackish, you may be able to get better 
results with the Gamma slider.

[Actual size view]

The image is displayed as actual size.

[Overall view]

The image is displayed to fit into the Viewer 
screen.

[Enlarged display]

The image is enlarged to 2, 3, 4, 8, or 16 
times.

Some ratios are not available for images of some 
sizes.

[Reduce display]

The image is reduced to 1/2, 1/3, 1/4, 1/8, or 
1/16.

- +

- +

- +
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What You Can Do with the Toolbar
By using the menu items on the menu bar, 
you can do the following:
[File] menu

[Save]
Overwrites and saves an image.

[Save As]
The [Save As] dialog box (see P.26) 
appears where you can save the image 
file.The file type and compression ratio can 
also be changed.

[Quit]
Closes the Viewer screen.

[Edit Image] menu

[Return to Original]
Cancel changes made on the Viewer 
screen and restore the original.

[Select Range]
You can select a range by clicking and 
dragging. This is used to copy the selected 
range in an image.

[Copy]
An image can be saved to clipboard and 
then pasted into another application. If a 
range is selected with [Select Range], only 
the selected range is copied. If no range is 
selected or [Select All] is selected, the 
entire image is copied.

[Select All]
Selects the entire image.This is used to 
copy images.

[Rotate]
You can rotate your images 90 degrees to 
the left or right. You can correct images to 
their proper vertical/horizontal orientation.

[Resize]
The [Resize] dialog box (see P.26) appears 
where you can resize the image to 1/2, 1/3, 
1/4, 1/8, or 1/16.

[Cropping]
You can crop a part of the image. When 
you click and drag to select a range, a 
message appears to confirm cropping. 
Click the [OK] button to crop the image.

[Auto Image Correction]
The brightness, contrast, sharpness, and 
hue are automatically adjusted to enhance 
images. The [Auto Image Correction] 
dialog box (see P.27) appears where you 
can preview the enhancement.

[Manual Image Correction]
The [Manual Image Correction] dialog box 
(see P.27) appears where you can adjust 
the brightness, contrast, sharpness, and 
hue by dragging the slider sideways.
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[Adust Edges Light Level]
The [Adust Edges Light Level] dialog box 
appears where you can adjust the light 
level (brightness) for areas around the 
center of the image, by dragging the slider 
sideways.

[Adust Edges Light Level] dialog box

[Correct Distortion]
The [Correct Distortion] dialog box 
appears.
Click the [Auxiliary Line] button to display 
the line as the criterion. You can correct the 
image distortion by dragging the slider 
sideways.
Grasp and drag the auxiliary line to move 
it. Grasp and drag the line end to change 
its direction or length.

[Correct Distortion] dialog box

[View] menu

[Overall view]
The image is displayed to fit into the 
Viewer screen.

[Actual size view]
The image is displayed as actual size.

[Enlarge]
The image is enlarged to 2, 3, 4, 8, or 16 
times.

Some ratios are not available for images of some 
sizes.

[Reduce]
The image is reduced to 1/2, 1/3, 1/4, 1/8, 
or 1/16.

[Help] menu

[About]
Displays the version of DU-10.

Auxiliary line
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Printing an Image

You can print a thumbnail display image.
There are ten layouts available.

To Print an Image
To print an image, follow the steps below.

1. Select [Print Setup] from the 
[File] menu.
The [Print Setup] dialog box appears.

2. Select a layout in [Print Type].

3. Make other settings as required.
For details on print setup, see the next 
section "How to Use the [Print Setup] 
Dialog Box".

4. Click the [OK] button.
Print setup is complete.

• To continue printing at step 4, click the [Print] button. 
The [Print] dialog box appears, and you can start 
printing.

• To print an image in a large size, select 1x1 in [Print 
Type] on the [Print Setup] dialog box.

• The GPS information will not be printed.

Using the [Print Setup] Dialog Box

1. [Print Type]
Select a layout for printing thumbnails.

2. [Title]
Prints a title at the top of the page. You 
can use a folder name or specify a 
character string for the title.

3. [Options]
Check the options to print an image with a 
frame, a shooting date, a printing date, 
the number of pages, and a file name. 

4. [Margin]
Specify the page margin widths.

5. [Print]
Bring up the [Print] dialog box to start 
printing.

6. [Printer Setup]
Make printer settings.

7. [OK]
Used for making print settings without 
actually printing.
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Checking the Printing Layout
You can check the print preview before 
printing.

1. Select [Print Preview] from the 
[File] menu.
The print preview screen appears.

Functions of the buttons shown at the top of 
the screen are as follows:

Making printer settings
Selecting [Printer Setup] in the [Print Setup] 
dialog box (available on the [File] menu) 
allows you to make printer-related settings 
such as selection of a printer, paper size, and 
paper feed method.

Printing Images
To print images, follow the steps below.

1. Select the images you want to 
print by clicking on them.
To select two or more contiguous 
images, click the first image and then 
click the last image while pressing the 
[Shift] key.
To select two or more distant images, 
click them one after another while 
pressing the [Ctrl] key.
To print all thumbnail images displayed, 
go to step 2 directly.

2. Select [Print] from the [File] 
menu.
The [Print] dialog box appears.

3. Check the printer name, and 
click the [Properties] button to 
make printer settings if required.

4. Perform either of the following 
operations:
• To print the selected images, select 

[Selection] in [Print range], specify the 
number of copies, and click the [OK] 
button.

• To print all images, specify the number 
of copies and click the [OK] button.

[Print] : Displays the [Print] dialog box to 
start printing.

[Next Page] : Displays the next page.
[Previous Page] : Displays the previous page.

[2 Pages] : Displays two pages on the screen at 
a time.

[Enlarge] : Zooms in on the page.
[Reduce] : Zooms out on the page.
[Close] : Closes the print preview screen.



Chapter 2
Getting to Enjoy 
Images on Your 
Computer
 (For Macintosh)

Section 1
Downloading Images to a 
Computer
This section explains how to display still images and 
movies you have downloaded to your computer.
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Connecting the Camera 
to a Computer

After installing the software on your 
computer, connect your camera to it.

1. Make sure the camera power is 
off.

2. Connect the USB cable to the 
USB port of your computer.

3. Connect the USB cable to the 
USB terminal of your camera.

Your camera turns on.

• To disconnect the camera from your computer:
 1.Turn your camera off.
 2.Unplug the USB cable.

• It is recommended that you use the AC Adapter 
(sold separately) when you are downloading images 
from your camera.

Downloading Images to 
Your Computer

After you have connected your camera to the 
computer, images are downloaded 
automatically.

Images are downloaded to your computer from the 
following memory sources.

Downloading methods differ (as described in 
the following table) depending on the 
environment used. Refer to the respective 
page to download your images.

When no memory card is 
loaded

When an SD Memory 
Card is loaded

Loads from internal 
memory

Loads from the SD 
Memory Card

For Mac OS 8.6 to 
9.2.2

Download using DL-10. P.35

For Mac OS X 10.1.2 
to 10.3

Download using the 
Mounter.

P.36
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For Mac OS 8.6 to 9.2.2
In Mac OS 8.6, Mac OS 9.1, or earlier 
versions, a folder called [Digital Camera] is 
created inside the root directory on the start-
up disc [Macintosh HD].
In Mac OS 9.1 to 9.2.2, a folder called [Digital 
Camera] is automatically created inside the 
[Documents] folder on the start-up disc 
[Macintosh HD].

1. Connect your camera to the 
computer using the USB cable.
The camera turns on, DL-10 starts, and 
the DL-10 window appears.

Image transfer begins automatically.

2. Click on the [File] menu and 
select [Quit].
DL-10 closes.

Using the Mounter
You can transfer images using the Mounter.

1. Connect your camera to the 
computer using the USB cable.
Your camera turns on.
When no SD Memory Card is loaded, 
the [Digital Camera] icon is displayed 
and you can view the image files stored 
in internal memory.

When an SD Memory Card is loaded,
 the [Digital Camera.SD] icon is 
displayed and you can view the image 
files stored on the SD Memory Card 
loaded.

2. Double-click the displayed icon.
It can be handled in the same way as a 
normal drive. If you double-click the 
icon, a folder called [DCIM] is displayed 
and a folder called [Digital Camera] 
within that folder is displayed. The 
image files you shot are inside the 
[Digital Camera] folder.
You can use drag and drop to copy files 
to the hard disk.

When using the Mounter, you cannot write data onto 
an SD memory card.

• If you want to start DL-10 when the camera is not 
connected, double-click the [DL-10] icon in the 
Control Panel folder, which is inside the System 
Folder.

• Images downloaded by DL-10 are saved in folders 
with the date of each shot, inside the [Digital 
Camera] folder. When using the Mounter, you can 
specify a folder where the images will be saved.

For how to change the Save Destination Folder, see 
P.38.
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For Mac OS X 10.1.2 to 10.3
1. Connect your camera to the 

computer using the USB cable.
Your camera turns on.
When no SD Memory Card is loaded, 
the [Digital Camera] icon is displayed 
and you can view the image files stored 
in internal memory.

When an SD Memory Card is loaded, 
the [Digital Camera.SD] icon is 
displayed and you can view the image 
files stored on the SD Memory Card 
loaded.

2. Double-click the displayed icon.
It can be handled in the same way as a 
normal drive. If you double-click the 
icon, a folder called [DCIM] is displayed 
and a folder called [Digital Camera] 
within that folder is displayed. The 
image files you shot are inside the 
[Digital Camera] folder.
You can use drag and drop to copy files 
to the hard disk.
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How to Use DL-10

DL-10 is a software program to import 
images from the camera to a computer.
By simply connecting the camera to your 
computer via a USB cable, images are 
automatically imported to the computer.
On the DL-10 window, you can make various 
settings including auto-saving upon 
connection and the destination folder (where 
images will be saved).

Starting
Connecting the camera to your computer 
automatically starts DL-10 and begins 
importing of images from the camera

Quitting
To quit DL-10, select [Exit] from the DL-10 
menu bar.

Restarting
To restart DL-10 after quitting, double-click 
the [DL-10] icon in the Control Panel folder in 
the system folder.

The DL-10 Window
Once DL-10 starts up, the following DL-10 
menu bar and window appear on the 
computer screen.

1. [About DL-10]
Displays the version of DL-10.

2. [Quit]
Closes DL-10.

3. [Option settings]
Specifies where to save images, or which 
application to launch when you press the 
Application button and after saving.(P.38)

[Background illustration]
If you select this, a sub-menu will appear, 
allowing you to change the background 
design of the DL-10 window.

Sub-menu Figure

4. [Save Button]
Click this and the images are downloaded 
from your camera.

5. [Application Button]
The application registered in Optional 
Settings is launched.

6. [Indicator]
The indicator lights if the camera is 
connected via USB cable.
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How to Use the Optional Settings
If you select [Optional Settings] from the [DL-10 
Settings] menu, the [Optional Settings] dialog box 
appears.

Item Description Initial Setting

1. [Automatically save 
on connection]

If you check this box, once your camera is connected to the computer, 
images are automatically downloaded and saved.
If you uncheck the box, your images will not be download automatically 
when you connect your camera to the computer. Click the [Save] button 
when you want to download.

Transfer files 
automatically

2. [Choose] Specifies which folder to save your images in.
For Mac OS 8.6, Mac OS 9.1, or earlier versions, it is in the [Digital 
Camera] folder of the Root Directory on the Start-up disc [Macintosh HD]. 
For Mac OS 9.1 to 9.2.2, it is specified in the [Digital Camera] folder inside 
the [Documents] folder on the Start-up disc [Macintosh HD], so if you want 
to change it, click the [Select] button and in the dialog box that appears, 
select the folder you wish to specify.

3. [Create folder] Specifies how to create a folder.
[Do not Create]

Your downloaded images will all be saved in the folder specified in item 2.
[For each date photographed]

Creates a new folder assigning the date the images were shot as the 
folder name, and saves images shot on the same day in the same folder.

For example, if shot on May 1, 2004: [20040501] folder
[Date Transferred + Number Transferred]

Creates a new folder for each time images are saved and saves the 
images shot at the same time in the same folder.
For example, if saved twice on May 1, 2004: 
[20040501_001] folder, [20040501_002] folder

For each date 
photographed

4. [The same image will 
not be saved.]

You can specify this only when you have selected [For each date 
photographed] for folder name or if you did not check [Automatically create 
folder on saving] in [Create folder].
Images imported once are not imported anymore. To allow the function to 
work properly, the camera's clock information must be set properly.

Do not save same 
image.

5. [Save and start 
application software]

If this is checked, an application will be launched after saving.
If this is unchecked, no application will be launched.

Do not start 
application after 
transfer

6. [Choose] Specify the name of the application you want to launch after you save. Click 
the [Choose] button to display the dialog box, and then specify which 
application to use.



Troubleshooting
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About computer connection and software

Symptom 1 Cannot download images

Measure 1
Your computer does not recognize the camera correctly.
Follow the steps below.
For Windows 98/98SE/Me

Step 1: First, follow the steps below.
1. Load the CD-ROM into your computer.
2. Connect your camera via the USB cable to your computer.
3. Click the [Start] button on the Windows taskbar to display the [Start] menu.
4. On the [Start] menu, point to [Settings], and then click [Control Panel].
5. On the Control Panel displayed, double-click the [System] icon.
6. On the [System Properties] screen displayed, double-click the [Device Manager] tab.
7. On the [Device Manager] tab page displayed, click [+] on the left side of [Other Devices].
8. Check if there is [DSC 724] below it. If there is, click [DSC 724], and then click the [Delete] 

button at the bottom of the [Device Manager] tab.
The entry [DSC 724] is deleted.

9. Click [OK] to close the [System Properties] screen.
10.When the display returns to the Control Panel, double-click the [Add/Remove] icon. 
11.On the [Add/Remove Applications Properties] screen displayed, select [DSC Software], 

and then click the [Add/Remove] button.
This uninstalls the DSC Software.

12.Click [OK] to close the [Add/Remove Applications Properties] screen.
13.Click the [x] (Close) button to close the Control Panel.
14.Turn off your camera and computer.
15.Turn your computer back on and reinstall the software from the CD-ROM.

*At this time, do not connect your camera.
16.Connect your camera via the USB cable to your computer.

When the computer recognizes the camera, the [New Hardware] screen launches and 
your camera is registered by the computer.
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Step 2: If your computer still does not recognize the camera, follow the steps below.
1. Load the CD-ROM into your computer.
2. Connect your camera via the USB cable to your computer.
3. Click the [Start] button on the Windows taskbar to display the [Start] menu.
4. On the [Start] menu, point to [Settings], and then click [Control Panel].
5. On the Control Panel displayed, double-click the [System] icon.
6. On the [System Properties] screen displayed, double-click the [Device Manager] tab.
7. On the [Device Manager] tab page displayed, click [+] on the left side of [Port COM/LPT] 

to open.
8. Check whether or not there is an unknown device symbol (!) indicated for [DSC Camera 

Port]. If there is, select it, and then click the [Delete] button at the bottom of the [Device 
Manager] tab to delete it.

9. Click [+] on the left side of [Universal Serial Controller] to open.
10.Check whether or not there is an unknown device symbol (!) indicated for [DSC USB 

Virtual COM] below it. If there is, select it, and then click the [Delete] button at the bottom 
of the [Device Manager] tab to delete it.

11.Click [OK] to close the [System Properties] screen.
12.When the display returns to the Control Panel, double-click the [Add/Remove] icon. 
13.On the [Add/Remove Applications Properties] screen displayed, select [DSC Software], 

and then click the [Add/Remove] button.
This uninstalls the DSC Software.

14.Click [OK] to close the [Add/Remove Applications Properties] screen.
15.Click the [x] (Close) button to close the Control Panel.
16.Turn off your camera and computer.
17.Turn your computer back on and reinstall the software from the CD-ROM.

*At this time, do not connect your camera.
18.Connect your camera via the USB cable to your computer.

When the computer recognizes the camera, the [New Hardware] screen launches and 
your camera is registered by the computer.
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For Windows 2000
Step 1: First, follow the steps below.
1. Load the CD-ROM into your computer.
2. Connect your camera via the USB cable to your computer.
3. Click the [Start] button on the Windows taskbar to display the [Start] menu.
4. On the [Start] menu, point to [Settings], and then click [Control Panel].
5. On the Control Panel displayed, double-click the [System] icon.
6. On the [System Properties] screen displayed, double-click the [Device Manager] tab.
7. On the [Hardware] tab page displayed, click the [Device Manager] button.
8. On the [Device Manager] screen displayed, click [+] on the left side of [Other Devices].
9. Check if there is [DSC 724] below it. If there is, click [DSC 724], and then click the [Delete] 

from the [Operation] menu.
The entry [DSC 724] is deleted.

10.Click the [x] (Close) button to close the [Device Manager] screen.
11.Click [OK] to close the [System Properties] screen.
12.When the display returns to the Control Panel, double-click the [Add/Remove] icon. 
13.On the [Add/Remove Applications Properties] screen displayed, select [DSC Software], 

and then click the [Change/Remove] button.
This uninstalls the DSC Software.

10.Click the [x] (Close) button to close the [Add/Remove Applications Properties] screen.
15.Click the [x] (Close) button to close the Control Panel.
16.Turn off your camera and computer.
17.Turn your computer back on and reinstall the software from the CD-ROM.

*At this time, do not connect your camera.
18.Connect your camera via the USB cable to your computer.

When the computer recognizes the camera, the [New Hardware] screen launches and 
your camera is registered by the computer.
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Step 2: If your computer still does not recognize the camera, follow the steps below.
1. Load the CD-ROM into your computer.
2. Connect your camera via the USB cable to your computer.
3. Click the [Start] button on the Windows taskbar to display the [Start] menu.
4. On the [Start] menu, point to [Settings], and then click [Control Panel].
5. On the Control Panel displayed, double-click the [System] icon.
6. On the [System Properties] screen displayed, double-click the [Device Manager] tab.
7. On the [Hardware] tab page displayed, click the [Device Manager] button.
8. On the [Device Manager] screen displayed, click [+] on the left side of [Port COM/LPT] to 

open.
9. Check whether or not there is an unknown device symbol (!) indicated for [DSC Camera 

Port].If there is, click it, and then click the [Delete] from the [Operation] menu.
10.Click the [x] (Close) button to close the [System Properties] screen.
11.When the display returns to the Control Panel, double-click the [Add/Remove] icon. 
12.On the [Add/Remove Applications Properties] screen displayed, select [DSC Software], 

and then click the [Change/Remove] button.
This uninstalls the DSC Software.

áL Click the [x] (Close) button to close the [Add/Remove Applications Properties] screen.
14.Click the [x] (Close) button to close the Control Panel.
15.Turn off your camera and computer.
16.Turn your computer back on and reinstall the software from the CD-ROM.

*At this time, do not connect your camera.
17.Connect your camera via the USB cable to your computer.

When the computer recognizes the camera, the [New Hardware] screen launches and 
your camera is registered by the computer.
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For Windows XP
Step 1: First, follow the steps below.
1. Load the CD-ROM into your computer.
2. Connect your camera via the USB cable to your computer.
3. Click the [Start] button on the Windows taskbar to display the [Start] menu.
4. On the [Start] menu, click [Control Panel].
5. On the Control Panel displayed, click [Switch to Classic Display].
The display changes its appearance and the [System] icon appears.
6. Double-click the [System] icon.
7. On the [System Properties] screen displayed, double-click the [Device Manager] tab.
8. On the [Hardware] tab page displayed, click the [Device Manager] button.
9. On the [Device Manager] screen displayed, click [+] on the left side of [Other Devices].

Check if there is [DSC 724] below it. If there is, right-click [DSC 724] to display the menu 
and select [Update Driver].

11.Windows will display the [Hardware Update Wizard] screen. At this point, insert the CD-
ROM into the CD-ROM drive on your computer.

12.Make sure that [Install the software automatically (Recommended)] is selected, and then 
click [Next].

13.When the [Completing the Hardware Update Wizard] screen appears, click [Finish].
14.Click the [x] (Close) button to close the [Device Manager] screen.
15.Click [OK] to close the [System Properties] screen.
16.Click the [x] (Close) button to close the Control Panel.
17.Turn off your camera and computer.
18.Turn your computer back on and reinstall the software from the CD-ROM.

*At this time, do not connect your camera.
19.Connect your camera via the USB cable to your computer.

When the computer recognizes the camera, the [New Hardware] screen launches and 
your camera is registered by the computer.
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Step 2: If your computer still does not recognize the camera, follow the steps below.
1. Load the CD-ROM into your computer.
2. Connect your camera via the USB cable to your computer.
3. Click the [Start] button on the Windows taskbar to display the [Start] menu.
4. On the [Start] menu, click [Control Panel].
5. On the Control Panel displayed, click [Switch to Classic Display].

The display changes its appearance and the [System] icon appears.
6. Double-click the [System] icon.
7. On the [System Properties] screen displayed, double-click the [Device Manager] tab.
8. On the [Hardware] tab page displayed, click the [Device Manager] button.
9. On the [Device Manager] screen displayed, click [+] on the left side of [Imaging Devices] 

to open.
10.Check whether or not there is an unknown device symbol (!) indicated for [DSC 724]. If 

there is, right-click the unknown device symbol to display the menu and select [Driver 
Update].

11.Windows will display the [Hardware Update Wizard] screen. At this point, insert the CD-
ROM into the CD-ROM drive on your computer.

12.Make sure that [Install the software automatically (Recommended)] is selected, and then 
click [Next].

13. When the [Completing the Hardware Update Wizard] screen appears, click [Finish].
14.Click the [x] (Close) button to close the [Device Manager] screen.
15.Click [OK] to close the [System Properties] screen.
16.Click the [x] (Close) button to close the Control Panel.
The driver is installed and your computer recognize the camera correctly.
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Measure 2
For Windows 98/98SE/Me, the COM Port setting may be wrong.
Follow the steps below.

1. Connect your camera via the USB cable to your computer.
2. Click the [Start] button on the Windows taskbar to display the [Start] menu.
3. On the [Start] menu, point to [Settings], and then click [Control Panel].
4. On the Control Panel displayed, double-click the [System] icon.
5. On the [System Properties] screen displayed, double-click the [Device Manager] tab.
6. On the [Device Manager] tab page displayed, click [+] on the left side of [Port COM/LPT] 

to open.
7. Click [DSC Camera Port] under [Port COM/LPT], and then click the [Properties] button at 

the bottom of the [Device Manager] tab.
8. On the [DSC Camera Port Properties] screen displayed, Click the [Port Select] tab.
9. On the [Port Select] tab page displayed, select a COM Number not being used from [Port-Name].

The port (COM number) currently allocated for your camera is indicated by a "*".
Immediately after installing the USB driver, COM 7 should be selected, so select a 
number above COM8.

10.Click [OK] to close the [DSC Camera Port Properties] screen.
11.Click [OK] to close the [System Properties] screen.
12.Click the [x] (Close) button to close the Control Panel.

Measure 3
Your camera may not be recognized correctly if you connect to the USB Port of your computer
via a USB hub.
Follow the steps below to change the USB port.

• Connect your camera directly to the USB port of your computer.
• If there are several root ports, change to another one.

If you are using a port other than USB, connect via a USB port.

Measure 4
The batteries may have worn out.
Check whether the batteries have worn out. If worn out, replace them with new ones. 

Measure 5
The free space on the hard disk in your computer may be insufficient.
Check whether the hard disk has a space for running Windows, and the drive where you are
loading image files has the same capacity or more as that of the memory card inserted in the
camera.
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Symptom 2 Even if you check [The same image will not be saved] in the DL-10 
Optional Settings, the same images are loaded into your computer.

Measure
The camera's clock is incorrectly set or the camera's clock information has been reset.
To allow the [The same image will not be saved] function to work properly, the camera's clock
information must be set properly. Set it properly.

Symptom 3 Files loaded from the camera into the computer were deleted. You 
attempted to load the same files from the camera again but failed. 

Measure
If [The same image will not be saved] is checked in the DL-10 Optional Settings, files loaded into
your computer once cannot be loaded again. In the DL-10 Optional Settings, uncheck [The
same image will not be saved].

Symptom 4 Cannot play back movies

Measure

DirectX may not be installed. (Windows 98/98SE/Me/2000) Install DirectX from the CD-ROM.

Symptom 5 DL-10 is always activated when the camera is connected to a Windows XP 
computer through a USB cable.

Measure
Connect the camera to the computer through the USB cable, and then open My Computer from
the Start menu on Windows Taskbar. Right-click the camera icon on the My Computer screen
and click Properties to open the camera's Properties screen. Click the [Event] tab on the
Properties screen. For the computer operation, select "None" or "Select Program to Execute "
and click OK. If "None" is selected, nothing happens when the camera is connected to the
computer. If "Select Program to Execute" is selected, a screen is displayed each time the
camera is connected to the computer. Then you can choose a program to activate.
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